Quick Start Guide
to the
RAAF Command Support System Prototype

M. Carthigaser

A Report from Task Air 93/025
"RAAF Command Support Working Group Study"

DSTO-TR-0272

ABSTRACT

Technical Report

This Guide provides a hands-on introduction to the RAAF Command Support System Prototype—software produced as part of Task Air 93/025 to present a visual demonstration of the concepts identified in the Analysis. Its purpose is to assist users in installing and using the software in the quickest possible way, through step-by-step instructions.

The Prototype was developed to run on a PC with Microsoft Windows 3.1. Produced solely as a concept demonstrator, the Prototype exhibits the minimum functionality necessary to demonstrate the concepts we believe should be incorporated in a future RAAF Command Support System.

APPROVED FOR PUBLIC RELEASE

UNCLASSIFIED
Quick Start Guide
to the
RAAF Command Support System Prototype

EXECUTIVE SUMMARY

This Guide provides a hands-on introduction to the RAAF Command Support System Prototype—software produced as part of Task Air 93/025 to present a visual demonstration of the concepts identified in the Analysis. Its purpose is to assist users in installing and using the software in the quickest possible way, through step-by-step instructions.

The Prototype was developed to run on a PC with Microsoft Windows 3.1. Produced solely as a concept demonstrator, the Prototype exhibits the minimum functionality necessary to demonstrate the concepts we believe should be incorporated in a future RAAF Command Support System.
M. Carthigaser
Electronics and Surveillance Research Laboratory
Defence Science and Technology Organisation

Malathi Carthigaser is a Professional Officer Class 2 within the Command Support Systems Group. She has been working at DSTO since graduating from the Australian National University in 1992 with a combined degree in Science and Economics (BEc/BSc).
Contents

CONTENTS .................................................................................................................. vii

ABBREVIATIONS ..................................................................................................... ix

1. INTRODUCTION ................................................................................................. 1

2. ABOUT THIS GUIDE .......................................................................................... 1

3. SYSTEM REQUIREMENTS .................................................................................. 1
   3.1. Hardware Requirements .............................................................................. 1
   3.2. Software Requirements .............................................................................. 2
   3.3. System Settings ........................................................................................... 2
       3.3.1. Date Formats .................................................................................. 3
       3.3.2. Path Statement in Autoexec.bat File .................................................. 3
       3.3.3. Share.exe ....................................................................................... 3
       3.3.4. File Associations ........................................................................... 3
       3.3.5. Suggested Colour Scheme .................................................................. 3

4. INSTALLATION ................................................................................................... 4
   4.1. Running Setup ............................................................................................. 4
   4.2. Programs Installed ...................................................................................... 4
   4.3. Files Installed .............................................................................................. 5
   4.4. Databases ................................................................................................... 5

5. DEMONSTRATION ............................................................................................. 6
   5.1. Demonstration Setup .................................................................................. 6
   5.2. Start Prototype ........................................................................................... 6
   5.3. CDRTFG, Battle Staff, Air Headquarters .................................................. 6
   5.4. OPSO, Operations, 81 Wing ..................................................................... 7
   5.5. CDRTFG, Battle Staff, Air Headquarters .................................................. 9
   5.6. Plans TF, Plans, Air Headquarters ............................................................. 11
   5.7. OPSO, Operations, 81 Wing ..................................................................... 12
   5.8. Exit Prototype ............................................................................................ 14

6. REFERENCES ..................................................................................................... 14
## Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ATO</td>
<td>Air Tasking Order</td>
</tr>
<tr>
<td>ATR</td>
<td>Air Tasking Order Request</td>
</tr>
<tr>
<td>CDRTFG</td>
<td>Commander Tactical Fighter Group</td>
</tr>
<tr>
<td>COTS</td>
<td>Commercial Off The Shelf</td>
</tr>
<tr>
<td>CSS</td>
<td>Command Support System</td>
</tr>
<tr>
<td>EW</td>
<td>Electronic Warfare</td>
</tr>
<tr>
<td>HQ82Wing</td>
<td>Headquarters 82 Wing</td>
</tr>
<tr>
<td>Intel</td>
<td>Intelligence</td>
</tr>
<tr>
<td>INTSUM</td>
<td>Intelligence Summary</td>
</tr>
<tr>
<td>OPORD</td>
<td>Operations Order</td>
</tr>
<tr>
<td>OPSO</td>
<td>Operations Officer</td>
</tr>
<tr>
<td>Plans TF</td>
<td>Plans Tactical Fighter</td>
</tr>
<tr>
<td>RAAF</td>
<td>Royal Australian Air Force</td>
</tr>
<tr>
<td>SQN</td>
<td>Squadron</td>
</tr>
</tbody>
</table>
1. Introduction

A Prototype of a future RAAF Command Support System was produced as part of Task Air 93/025. The Prototype is used to present a visual demonstration of the concepts identified in the Analysis—concepts which we believe should be incorporated into a future Command Support System.

The Prototype was implemented for Microsoft Windows 3.1, using Microsoft Visual Basic 3.0 with the Microsoft Access 1.1 database engine and MicroHelp’s VBTools 3.0 add-on. The Prototype produced is solely a concept demonstrator, however, whose level of functionality is sufficient only to demonstrate the concepts described.

Please note that there are two versions of the Prototype—the basic Prototype, and one tailored to specific demonstrations. This document describes how to use the demonstration version.

2. About This Guide

This Guide provides a hands-on introduction to the RAAF Command Support System Prototype. Its purpose is to assist users to install and use the software in the quickest possible way. As an introductory document, it supplies users with instructions for only a sample of the features that are available.

For more detailed information, please refer to the following documents:

- Prototype Technical Documentation [1].
- Prototype User Interfaces for Future RAAF Command Support Systems [2].

This guide assumes that users are familiar with the Microsoft Windows 3.1 user interface.

3. System Requirements

This Guide provides instructions for a single user to operate the Prototype on a stand-alone personal computer, thereby restricting the number of features that may be accessed. Additional hardware and software are required to exercise the full capabilities of the Prototype. Two connected computers with access to a common or shared drive are needed to demonstrate a shared information space.

3.1. Hardware Requirements

The Prototype has been tested on an IBM PS2 Model 77 Personal Computer, with a 486DX2 66MHz processor, 16 MB RAM, 360 MB SCSI hard disk, 3.5" 1.44 MB floppy disk drive, running the IBM DOS 5.0 operating system and Microsoft Windows 3.1. A 1024x768 pixel (XGA) resolution graphics and a mouse is also required.
The minimum hardware requirement for running the Prototype was not determined, but the above description of the environment used for developing and demonstrating the Prototype should be sufficient for deciding other suitable hardware formats.

To demonstrate communications and the sharing of information between users, an additional computer running the Prototype software, and the use of a common or shared drive is also needed. This requirement was met during development, by connecting two machines to an Ethernet local area network with Novell Netware 4.01 and sharing files using a file server.

For further information on hardware requirements, please refer to:

Section 4: Hardware, Prototype Technical Documentation [1].

3.2. Software Requirements

The RAAF CSS Prototype software is available on three 3.5” 1.44 MB floppy disks. The three disk set contains the Prototype’s executable programs, databases and source code (~1.5 MB executables, ~1.5 MB source code, ~4 MB support files and ~2.8 MB dynamic link libraries).

The Prototype software is integrated with several Commercial-Off-The-Shelf (COTS) products which also need to be installed. These applications are listed below:

- Microsoft Windows 3.1 Paintbrush.
- Microsoft Windows 3.1 Sound Recorder.
- Microsoft Windows 3.1 Clipboard Viewer.
- Microsoft Windows 3.1 Write.
- Microsoft Windows 3.1 NotePad.
- Microsoft Excel 4.0a.
- Microsoft PowerPoint 3.0.
- Lotus Media Manager.

For further details on the use of COTS products in the Prototype, please refer to:

Section 5.5: COTS Products, Prototype Technical Documentation [1].

3.3. System Settings

The value of several system attributes affect the working of the Prototype. Before executing the Prototype software, users should ensure that their system has the date format described below, the locations of the COTS products all appear in the autoexec.bat file, the autoexec.bat file includes a line for the share.exe program with specific parameters, and that appropriate file associations have been set for each COTS product. Instructions on these appear below.
For full details of the required system settings, please refer to:

Section 6.1: System Settings, Prototype Technical Documentation [1].

3.3.1. Date Formats

Set the date format for Microsoft Windows using the International option of the Control Panel, as described below. The Control Panel is located in the Main group of Program Manager.

- In the Date Format box, click the Change button.
- Select preferred DMY order.
- Short Date format: 05/03/95 (days and months with leading zeros).
- Long Date format: Sunday, 05 March, 1995.

3.3.2. Path Statement in Autoexec.bat File

Set the path statement in the autoexec.bat file to include the directories of the COTS applications listed in Section 3.2.

3.3.3. Share.exe

In the autoexec.bat file, include the line: share.exe /L:500.

3.3.4. File Associations

To associate particular file extensions with applications:

- Launch the Microsoft Windows File Manager.
- In the File Menu, select the Associate menu option.
- Enter the necessary file extensions and select the associated applications.

Associations required by the Prototype are listed below; file extensions are on the left and associated applications are on the right:

<table>
<thead>
<tr>
<th>File Extension</th>
<th>Associated Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>bmp, dib</td>
<td>PaintBrush (pbrush.exe)</td>
</tr>
<tr>
<td>clp</td>
<td>Clipboard Viewer (clipbrd.exe)</td>
</tr>
<tr>
<td>ppt</td>
<td>PowerPoint Presentation (pptview.exe)</td>
</tr>
<tr>
<td>txt</td>
<td>NotePad (notepad.exe)</td>
</tr>
<tr>
<td>wri</td>
<td>Write (write.exe)</td>
</tr>
<tr>
<td>xlc</td>
<td>Excel Chart (excel.exe)</td>
</tr>
<tr>
<td>xls</td>
<td>Excel Worksheet (excel.exe)</td>
</tr>
<tr>
<td>wav</td>
<td>Sound Recorder (soundrec.exe)</td>
</tr>
<tr>
<td>lsm, mmm</td>
<td>Media Manager (medman.exe)</td>
</tr>
</tbody>
</table>

3.3.5. Suggested Colour Scheme

The colour scheme for Microsoft Windows is set using the Colour option of the Control Panel. The Control Panel is located in the Main group of Program Manager.
4. Installation

4.1. Running Setup

Disk 1 of the RAAF CSS Prototype disk set contains a Setup program which greatly simplifies the installation of the software. The Setup program expands the compressed files and copies them to the relevant directories on the destination hard disk. It also creates a new program group in the Program Manager, which contains program items for all the Prototype programs. During the installation, the Setup program also prompts users for information such as the destination directories, and which disks to insert. Custom installations are also possible—with users able to select which components are installed.

To run Setup from the command line of the Program Manager:

- Place Disk 1 in a floppy disk drive.
- From the File menu of the Program Manager, select the Run option.
- At the command line, type the letter of the drive containing Disk 1 followed by :\setup.exe—for example a:\setup.exe.
- Click OK.

When prompted, follow the instructions.

4.2. Programs Installed

On completion of the Setup program, a RAAF CSS Prototype program group is created in the Program Manager.

The following program items are also created within this group:

- RAAF CSS Complete Prototype
- RAAF CSS Demo Demonstration version of the Prototype
- Mapping Tool Separate Mapping Tool
- Map Tool Demo Separate demonstration version of the Mapping Tool
- Briefing Tool Separate Briefing Tool
- Brief Organiser Separate Brief Organiser
Data Manager  This is used to manipulate the data in the Prototype's databases

RAAF CSS Setup  Setup program

All these programs are launched by double-clicking their icons.

4.3. Files Installed

The following directories are created during installation:

- \raafcss
- \raafcss\db
- \raafcss\shared

Files are added also to the following existing directories:

- \dos
- \windows\system

For a complete list of files installed, along with their locations, refer to Annex A of the Prototype Technical Documentation [1].

4.4. Databases

The Prototype uses two databases—raaf and taskinfo—located in the \raafcss\db directory. The database files have the extensions .mdb and .ldb. Backups of the taskinfo database files are included in the Prototype software and are located in the same directory. Backup database files have extensions .mbk and .lbk.

The backup files are used to set database tables to initial values before a demonstration is run, as the taskinfo database is updated during the demonstration of the Prototype.

To set the taskinfo database to its initial values:

1. Delete the old version of the database—files taskinfo.mdb and taskinfo.ldb.
2. Copy taskinfo.mdbk to taskinfo.mdb and taskinfo.lbk to taskinfo.ldb.

There should now be four taskinfo database files:

taskinfo.mdb, taskinfo.ldb, taskinfo.mbk and taskinfo.lbk

Note: It is easier to use the preceding steps to initialise the taskinfo database than it is to use the Data Manager, as a large number of tables may be involved.

Note: Always maintain backups of the initial database files.
5. Demonstration

This introduction to the RAAF CSS Prototype is based on the A Future Day in the Life of Air Command section of the document, An Operator’s Perspective of RAAF Command Support Systems [3].

The following instructions are organised by the positions they relate to.

All steps should be executed in sequence.

5.1. Demonstration Setup
Initialise the taskinfo database by following the steps in the above section on Databases.

System settings are described above in the Systems Settings section.

It is recommended that you exit all running applications and remove any background bitmaps on the Microsoft Windows desktop before you start the Prototype demonstration.

5.2. Start Prototype

(1) Start the RAAF CSS Prototype.

- Double-click the RAAF CSS Prototype program group in the Microsoft Windows Program Manager. All Prototype program items are shown.
- Double-click the RAAF CSS Demo icon.

The Logon to Position screen is displayed.

- Minimise the Microsoft Windows Program Manager.

5.3. CDRTFG, Battle Staff, Air Headquarters

View the 81 Wing Tasking Board and a related document.

(2) Logon to the system as CDRTFG in the Battle Staff at Air Headquarters.

Use the Logon to Position screen.

- From the Organisational Unit drop down box, select Air Headquarters.
- From the Functional Cell drop down box, select Battle Staff.
- From the Position drop down box, select CDRTFG.
- (Optional) In the Name text box, enter your name.
- Click OK.

CDRTFG’s desktop is displayed.
(3) Display 81 Wing’s Tasking Board.
   - On the CDRTFG’s desktop, double-click the 81 Wing Tasking Board icon. 
     Note: there will be some delays while the 81 Wing Tasking Board is displayed, 
     as the tasking board accesses the database and refreshes the mission data—
     the delays occur at regular intervals.

(4) Display the OPORD for 3SQN.
   - In the 3SQN training area of the tasking board, click any cell. A pop-up 
     menu appears.
   - Click the Display OPORD menu option.
   - To remove the OPORD, click the File menu, and click Exit.
   - To remove the Tasking Board, click Close in its control box.

5.4. OPSO, Operations, 81 Wing
Collaborate with the OPSO at 82 Wing to schedule a new Air Tasking Order Request 
involving both Wings.

Initially logged on as CDRTFG, Battle Staff, Air Headquarters.

(5) Logon to the system as the OPSO in the Operations functional cell at 81 Wing.
   - Click the Show Menu button on the panel at the top left of the screen.
   - Select the Change button from the panel menu.
   - Click the OK button when presented with the confirmation message: Are You 
     Are You Want to Quit the Role: CDRTFG? This will take you to the Logon to Position screen.
   - From the Organisational Unit drop down box, Select 81 Wing.
   - From the Functional Cell drop down box, select Operations.
   - From the Position drop down box, select OPSO.
   - (Optional) In the Name text box, enter your name.
   - Click OK.

The OPSO’s desktop is displayed.

(6) View the list of new Air Tasking Order Requests.
   - On the OPSO’s desktop, double-click the New ATRs icon.

(7) Display an Air Tasking Order Request.
In the second row of the Air Tasking Request List grid, click any cell of the Maritime Strike air tasking order request.

Position the Air Tasking Order Request at the top left hand corner of the screen.

To remove the Air Tasking Request List, select Close from its control box.

**View the Tasking Board.**

- Double-click the 81 Wing Tasking Board icon at the bottom of the screen.

**Locate the OPSO at 82 Wing, using the Navigation Tool.**

- Double-click the Navigation Tool icon located at the bottom of the screen.
- From the drop down box on the left, select Organisation Structure.
- From the drop down box on the right, select Positions.
- To expand the tree, click the right-angled arm of the Strike Reconnaissance Group node.
- To expand the tree, click the right-angled arm of the 82 Wing node.
- To expand the tree, click the right-angled arm of the HQ82Wing node.
- Select the Operations node. The positions within the Operations functional cell of 82 Wing appear on the right of the tool.

**Launch the Communications Tool.**

- Click the position OPSO.
- Drag and drop this position onto the Communications Tool icon at the bottom of the screen.

The Navigation Tool will close and the Communications Tool will be launched.

**Send the Route and EW plans to the OPSO at 82 Wing, using the Communications Tool.**

- Double-click the 81 Wing—Operations icon at the bottom of the screen. The Operations functional cell blackboard is displayed.
- Select the Route & EW Plan icon.
- Drag and drop this icon onto the Mail area of the Communications Tool.
- In the Communications Tool, click the Send button.
- Click OK when presented with the confirmation message: Send Information: Route & EW Plan to OPSO 82 Wing?
- Minimise the 81 Wing—Operations blackboard.
(12) Schedule the Air Tasking Order Request onto the tasking board.

- Select the Schedule menu option of the Maritime Strike air tasking order request. The Schedule form appears.
- From the Squadron drop down box, select 75SQN.
- From the Aircraft drop down box, select aircraft number 3.
- On the Schedule form, click OK.

After a few seconds, the mission appears on the tasking board.

- To remove the Air Tasking Order Request, select Close from the control box.
- To remove the tasking board, select Close from the control box.

5.5. CDRTFG, Battle Staff, Air Headquarters

View the Intelligence brief to reveal any threat situations. Use the Situation Awareness Display to display current situation and to plan a response. Display a sector centred at Darwin and re-allocate some aircraft (eight F/A-18s and two B-707s) graphically.

Initially logged on as OPSO, Operations, 81 Wing.

(13) Logon to the system as CDRTFG in the Battle Staff at Air Headquarters.

- Click the Show Menu button on the panel at the top left of the screen.
- Select the Change button from the panel menu.
- Click the OK button when presented with the confirmation message: Are You Are You Want to Quit the Role: OPSO? This will take you to the Logon to Position screen.
- From the Organisational Unit drop down box, select Air Headquarters.
- From the Functional Unit drop down box, select Battle Staff.
- From the Position drop down box, select CDRTFG.
- (Optional) In the Name text box, enter your name.
- Click OK.

CDRTFG’s desktop is displayed.

(14) View the Intelligence brief using the Briefing Tool.

- Double-click the Air Headquarters—Battle Staff icon at the bottom of the screen. The Battle Staff functional cell blackboard is displayed.
- Double-click the Battle Staff Briefs icon. The Battle Staff briefs is displayed.
• Double-click the Intel brief icon. The Briefing Tool is launched and displays an INTSUM as its first brief component.
• In the Brief menu of the Briefing Tool, select the Show Next option. The next brief component is displayed—the incident snapshot recorded earlier by the Mapping Tool.
• To end the brief, click the File menu of the Briefing Tool, and select Quit.
• Minimise the Air Headquarters—Battle Staff blackboard.

(15) View the current situation using the Situation Awareness Display.
• Double-click the SADI icon at the bottom of the screen—which launches the Mapping Tool.
• Maximise the map window.
• To zoom into the Darwin region, click the Display menu, and select Zoom-In.

Display the current disposition of assets:
• In the Show menu of the Mapping Tool, select the Military Assets option.
• In the Military Features window and check Enemy and Friendly Bases.
• In the Military Features window, check Enemy and Friendly Aircraft Tracks.
• In the Military Features window, check Enemy and Friendly Ships.
• In the Military Features window, click the Apply button.
• In the Military Features window, click Close.

(16) Setup a sector using the Situation Awareness Display.
• In the Place menu of the Mapping Tool, select the Define Sector option.

(17) Deploy eight F/A-18s and two B-707s to Darwin, using the Situation Awareness Display.
• Click right mouse button near Darwin base. A pop-up menu appears.
• Click the Place Asset pop-up menu option.
• From the Place Asset window, select the Friendly Aircraft symbol.
• As a label type 8 F/A-18.
• Hit the Enter key.
• Click right mouse button near Darwin base. A pop-up menu appears.
• Click the Place Asset pop-up menu option.
• From the Place Asset window, select the Friendly Aircraft symbol.
• As a label type 2 B-707.
5.6. Plans TF, Plans, Air Headquarters

Create a new detachment under 81 Wing thereby modifying the organisation structure. Allocate eight F/A-18s from 3SQN and two B-707s from 33SQN to the new detachment.

(18) Logon to the system as Plans TF in the Plans functional cell at Air Headquarters.

- Click the Show Menu button on the panel at the top left of the screen.
- Select the Change button from the panel menu.
- Click the OK button when presented with the confirmation message: Are You Are You Want to Quit the Role: CDRTFG? This will take you to the Logon to Position screen.
- From the Organisational Unit drop down box, select Air Headquarters.
- From the Functional Cell drop down box, select Plans.
- From the Position drop down box, select Plans TF.
- (Optional) In the Name text box, enter your name.
- Click OK.

PlansTF's desktop is displayed.

(19) Create a new detachment, in this case Detachment A, under 81 Wing, using the Organisation Tool.

- In the Define menu of the CSS main menu, select the Organisation menu option.
- Highlight 81 Wing in the hierarchical list on the left hand side of the screen.
- Select the Add new subordinate menu option of the Organisation Unit menu, in the Organisation Tool. The Enter New Organisation Unit form appears.
- Type Detachment A as the name of the new organisation unit.
- Click OK.

Detachment A appears in the hierarchical list on the left, and in the organisation structure chart on the right of the screen, below 81 Wing.

(20) Transfer eight F/A-18s from 3SQN, 81 Wing, TFG to Detachment A, 81Wing, TFG.
• Highlight 3SQN in the hierarchical list on the left hand side of the Organisation window.
• Select Aircraft Allocation menu option of the Resources menu, in the Organisation Tool. The Aircraft Allocation form will appear.
• Click any cell in the F/A-18 row of the Aircraft Allocation grid.
• Click the Reallocate button.
• Select 8 aircraft to re-allocate—use spin buttons or type the value.
• Click the To: text box and select Detachment A as the unit to which to re-allocate the aircraft by clicking Detachment A in hierarchical list, or by typing in the name.
• Click the Allocate button.

(21) Move two B-707s from 33SQN, 86Wing, ALG to Detachment A, 81Wing, TFG.

• Highlight 33SQN in the hierarchical list on the left hand side of the Organisation window.
• Select Aircraft Allocation menu option of the Resources menu, in the Organisation Tool. The Aircraft Allocation form appears.
• Click any cell in the B-707 row of the Aircraft Allocation grid.
• Click the Reallocate button.
• Select 2 aircraft to re-allocate—use spin buttons or by type in the value.
• Click the To: text box and select Detachment A as the unit to which to allocate the aircraft by clicking Detachment A in hierarchical list, or type in the name directly.
• Click the Allocate button.
• To close the Organisation Tool, click the Tool menu, and select the Exit option.

5.7. OPSO, Operations, 81 Wing

Change the 81 Wing Tasking Board structure to reflect the new organisation structure.

Initially logged on as Plans TF, Plans, Air Headquarters.

(22) Logon to the system as the OPSO in the Operations functional cell at 81 Wing.

• Click the Show Menu button on the panel at the top left of the screen.
• Select Change button from the panel menu.
• Click OK when presented with the confirmation message: Are You Sure You Want to Quit the Role: Plans TF? This will take you to the Logon to Position screen.
• From the Organisational Unit drop down box, select 81 Wing.
UNCLASSIFIED

- From the *Functional Cell* drop down box, select *Operations*.
- From the *Position* drop down box, select *OPSO*.
- (Optional) In the *Name* text box, enter your name.
- Click OK.

The OPSO's desktop is displayed.

(23) **Change the 81 Wing Tasking Board structure.**

Display the 81 Tasking Board in *Edit* mode:

- In the *Define* menu of the CSS main menu, select the *View* menu option. The Define View Tool is displayed.
- In the *Tool* menu, select *View* in the Define View Tool.
- In the *81 Wing OPS Board* row of the *Views* grid, click any cell.
- Click *Retrieve*.

The 81 Wing Tasking Board is displayed.

- Extend the height of 81 Wing OPS board to full screen height.

Modify the rows of the boards:

- In the *Board* menu of the Define View Tool, select the *Rows* menu option, to display the row attributes.
- From the *Organisation Unit* drop down box, select *81 Wing*.
- In the *Rows* grid, highlight the *3SQN* row.
- Select the *Refresh Squadron* button. After a few seconds, the tasking board is updated.
- In the *Rows* grid, highlight the *Detachment A B-707* row.
- Select the *Add Squadrons* button. The tasking board is updated.
- In the *Rows* grid, highlight the *Detachment A F/A-18* row.
- Select the *Add Squadrons* button. The tasking board is updated.
- In the *Board* menu, select the *Save* menu option and click OK to save the new board structure.
- To close the *Define View Tool*, in the *Tool* menu, select the *Exit* option.

(24) **View the new 81 Wing tasking board.**

- Double-click the *81 Wing Tasking Board* icon at the bottom of the screen. The modified tasking board is displayed.
To remove the tasking board, select Close in the control box.

5.8. Exit Prototype

(25) Exit the RAAF CSS Prototype and return to the Microsoft Windows desktop.

- From the Prototype’s main menu bar, select System.
- From the System menu, select the Quit option.
- Click OK when presented with the confirmation message: Are You Sure You Want to Quit?

6. References


Quick Start Guide to the RAAF Command Support System Prototype

Malathi Carthigaser

(DSTO-TR-0272)

DISTRIBUTION LIST

<table>
<thead>
<tr>
<th>Defence Science and Technology Organisation</th>
<th>Number of Copies</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chief Defence Scientist and members of the )</td>
<td>1 shared copy</td>
</tr>
<tr>
<td>DSTO Central Office Executive )</td>
<td>for circulation</td>
</tr>
<tr>
<td>Counsellor Defence Science, London</td>
<td>Doc Control Sheet</td>
</tr>
<tr>
<td>Counsellor Defence Science, Washington</td>
<td>Doc Control Sheet</td>
</tr>
<tr>
<td>Scientific Adviser POLCOM</td>
<td>1</td>
</tr>
<tr>
<td>Senior Defence Scientific Adviser</td>
<td>1</td>
</tr>
<tr>
<td>Assistant Secretary Scientific Analysis</td>
<td>1</td>
</tr>
<tr>
<td>Director, Aeronautical and Maritime Research Laboratory</td>
<td>1</td>
</tr>
<tr>
<td>Chief Air Operations Division</td>
<td>Doc Control Sheet</td>
</tr>
<tr>
<td>Chief Maritime Operations Division</td>
<td>Doc Control Sheet</td>
</tr>
<tr>
<td>Chief Weapon Systems Division</td>
<td>Doc Control Sheet</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Electronics and Surveillance Research Laboratory</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Chief, Information Technology Division</td>
<td>1</td>
</tr>
<tr>
<td>Chief Electronic Warfare Division</td>
<td>Doc Control Sheet</td>
</tr>
<tr>
<td>Chief Communications Division</td>
<td>1</td>
</tr>
<tr>
<td>Chief Land, Space and Optoelectronics Division</td>
<td>Doc Control Sheet</td>
</tr>
<tr>
<td>Chief High Frequency Radar Division</td>
<td>Doc Control Sheet</td>
</tr>
<tr>
<td>Chief Microwave Radar Division</td>
<td>Doc Control Sheet</td>
</tr>
<tr>
<td>Research Leader Command &amp; Control and Intelligence Systems</td>
<td>1</td>
</tr>
<tr>
<td>Research Leader Military Computing Systems</td>
<td>1</td>
</tr>
<tr>
<td>Research Leader Command, Control and Communications</td>
<td>1</td>
</tr>
<tr>
<td>Manager Human Computer Interaction Laboratory</td>
<td>1</td>
</tr>
<tr>
<td>Executive Officer, Information Technology Division</td>
<td>1</td>
</tr>
<tr>
<td>Head Software Engineering Group</td>
<td>1</td>
</tr>
<tr>
<td>Head, Trusted Computer Systems Group</td>
<td>1</td>
</tr>
<tr>
<td>Head, Command Support Systems Group</td>
<td>1</td>
</tr>
<tr>
<td>Head, Intelligence Systems Group</td>
<td>1</td>
</tr>
<tr>
<td>Head, Systems Simulation and Assessment Group</td>
<td>1</td>
</tr>
<tr>
<td>Head, Exercise Analysis Group</td>
<td>1</td>
</tr>
<tr>
<td>Head, C3I Systems Engineering Group</td>
<td>1</td>
</tr>
<tr>
<td>Head, Computer Systems Architecture Group</td>
<td>1</td>
</tr>
<tr>
<td>Head, Information Management Group</td>
<td>1</td>
</tr>
<tr>
<td>Head, Information Acquisition &amp; Processing Group</td>
<td>1</td>
</tr>
<tr>
<td>Publications &amp; Publicity Officer ITD</td>
<td>1</td>
</tr>
<tr>
<td>Author (Malathi Carthigaser)</td>
<td>1</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HQADF</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Director General Force Development (Air)</td>
<td>1</td>
</tr>
<tr>
<td>Director General Force Development (Joint)</td>
<td>1</td>
</tr>
</tbody>
</table>
Navy Office

Navy Scientific Adviser 1

Army Office

Scientific Adviser - Army 1

Air Office

Air Force Scientific Adviser 1
Air Commander, Australia 1
Director Communications and Information Systems - Air Force 1
Commander, AirLift Group 1
Commander, Maritime Patrol Group 1
Commander, Strike Reconnaissance Group 1
Commander, Tactical Fighter Group 1
COPS at Air Headquarters 1
S01 Information Systems at Air Headquarters 1
DAFFOL 1

Libraries and Information Services

Defence Central Library, Technical Reports Centre 1
Manager, Document Exchange Centre (for retention) 1
National Technical Information Services, United States 2
Defence Research Information Centre, United Kingdom 2
Director, Scientific Information Services, Canada 1
Ministry of Defence, New Zealand 1
National Library of Australia 1
Defence Science and Technology Organisation Salisbury, Research Library 2
Library Defence Signals Directorate, Canberra 1
AGPS 1
British Library, Document Supply Centre 1
Parliamentary Library of South Australia 1
The State Library of South Australia 1
Spares, DSTOS, Research Library 6
## Department of Defence

### DOCUMENT CONTROL DATA SHEET

<table>
<thead>
<tr>
<th>3a. AR Number</th>
<th>3b. Establishment Number</th>
<th>3c. Type of Report</th>
<th>4. Task Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR-009-424</td>
<td>DSTO-TR-0272</td>
<td>TECHNICAL REPORT</td>
<td>AIR 93/025</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>OCTOBER 1995</td>
<td>N/A</td>
<td>U</td>
<td>26</td>
<td>3</td>
</tr>
</tbody>
</table>

10. Title: Quick Start Guide to the RAAF Command Support System Prototype

11. Author(s): M. Carthigaser

13a. Corporate Author and Address

Information Technology Division
Electronics and Surveillance Research Laboratory
PO Box 1500 SALISBURY SA 5108

13b. Task Sponsor: Air Force

12. Downgrading/ Delimiting Instructions: N/A

14. Officer/Position responsible for Security: N/A

14. Officer/Position responsible for Downgrading: N/A

15. Secondary Release Statement of this Document

APPROVED FOR PUBLIC RELEASE.

Any enquiries outside stated limitations should be referred through DSTIC, Defence Information Services, Department of Defence, Anzac Park West, Canberra, ACT 2600.

16a. Deliberate Announcement

No limitation.

16b. Casual Announcement (for citation in other documents)

☐ No Limitation ☐ Ref. by Author, Doc No and date only

17. DEFTEST Descriptors

- Computer Software
- RAAF Command Support System

18. DISCAT Subject Codes: N/A

19. Abstract

This Guide provides a hands-on introduction to the RAAF Command Support System Prototype-software produced as part of Task Air 93/025 to present a visual demonstration of the concepts identified in the Analysis. Its purpose is to assist users in installing and using the software in the quickest possible way, through step-by-step instructions.

The Prototype was developed to run on a PC with Microsoft Windows 3.1. Produced solely as a concept demonstrator, the Prototype exhibits the minimum functionality necessary to demonstrate the concepts we believe should be incorporated in a future RAAF Command Support System.